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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 
evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 
service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 

 

 
EXPORT CONTROL 
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Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 
VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

• VibroSight software version 7.4.0 
(part numbers (PNRs) software license: 608-001-000-001/Codes 
and software: 609-010-000-001 on physical media (USB device (flash drive/key))). 

This document contains information about changes to the software since the previously released version 
(VibroSight 7.3.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire machinery protection system (MPS) and/or 
condition monitoring system (CMS), refer to the following Meggitt SA documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-227A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-234A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay module data sheet 
        (document reference 268-125) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring modules data sheet 
        (document reference 660-020-010-211A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 7.3.0 (document reference 660-010-013-236A) 

• VibroSight 7.2.0 (document reference 660-010-013-235A) 

• VibroSight 7.1.0 (document reference 660-010-013-234A) 

• VibroSight 7.0.0 (document reference 660-010-013-233A) 
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• VibroSight 6.1.0 (document reference 660-010-013-232A) 

• VibroSight 6.0.0 (document reference 660-010-013-231A) 

• VibroSight 5.1.0 (document reference 660-010-013-230A) 

• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 

• VibroSight 4.0.0 (document reference 660-010-013-227A) 

• VibroSight 3.8.0 (document reference 660-010-013-226A) 

• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 

• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 

• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 
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• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E). 

 

Use of the release notes 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 
following terminology is used in this document: 

 

• VM600Mk2/VM600 modules/card(s) – to refer to VibroSight compatible cards that are installed in a 
VM600Mk2/VM600 rack (that is, the first generation of VM600 systems). 

The currently available VM600Mk2/VM600 modules/cards that are designed for operation with the VibroSight 
software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Note: It is important to note that VibroSight Configurator is still used for the configuration of these 
VM600Mk2/VM600 modules/cards/systems. 

Where XMx16 is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T 
cards, unless otherwise stated. 

Where CPUx is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless otherwise 
stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modules that are installed in a VM600Mk2 rack (that is, 
the second generation of VM600 systems). 

The currently available VM600Mk2 modules that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module (standard and SIL versions), the 
RLC16Mk2 relay module and the CPUMMk2 + IOCNMk2 rack controller and communications interface module. 

Note: It is important to note that VibroSight Protect is used for the configuration of VM600Mk2 modules/systems. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 and 
VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 

Where VSV30x is used in this document, it refers to VSV301 and VSV300 modules, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 7.4.0 is a minor level release and a new license key file is not required 
for updates and upgrades from VibroSight 7.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 
For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 
support. See 7 Customer support. 

 

 

2 Features 

General 

2.1 VM600Mk2 SIL alarms and relays 

For the SIL versions of the VM600Mk2 modules, namely the MPC4Mk2 + IOC4Mk2 SIL machinery protection and 
condition monitoring module and the RLC16Mk2 SIL relay module, alarms and relays can now be freely configured 
as latched or not latched as required by the application whereas previously, such elements had to be configured as 
latched (enforced by software). 

Accordingly, in VibroSight Protect, when configuring alarms and/or relays on MPC4Mk2 + IOC4Mk2 SIL and 
RLC16Mk2 SIL modules, Latched controls are now available to be selected (alarm or relay = latched) or cleared 
(alarm or relay ≠ not latched) as required. 

Previously, when configuring alarms and/or relays on VM600Mk2 SIL modules, any alarm and/or relay Latched 
controls were always automatically configured and displayed as selected (alarm or relay = latched) and could not 
be changed by the user, as they were effectively unavailable (grayed out). 

See the comparison of the different versions of the VM600Mk2 modules given in the table below. 
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Different versions of the VM600Mk2 modules 

Standard versions: 
MPC4Mk2 + IOC4Mk2 and RLC16Mk2 

SIL versions: 
MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL 

 

Aluminium (silver) front panels 
(MPC4Mk2 + IOC4Mk2, RLC16Mk2) 

Aluminum (silver) front panels 
with yellow/orange “SIL Safety” labeling 
(MPC4Mk2 + IOC4Mk2 SIL, RLC16Mk2 SIL) 

 

One electronics processing module on MPC4Mk2 for all 
functionality (measurements, management and interfacing) 

Three electronics processing modules on MPC4Mk2 SIL: 
• 2 × processing modules for measurements 

(with measurement redundancy with cross-checking) 
• 1 × processing module for management and interfacing 

Separation (firmware only) of 
machinery protection system (MPS) and 

condition monitoring system (CMS) 
functionality/processing on the MPC4Mk2 module 

Complete separation (hardware and firmware) of 
machinery protection system (MPS) and 

condition monitoring system (CMS) 
functionality/processing on the MPC4Mk2 SIL module 

MPC4Mk2 + IOC4Mk2 module only runs diagnostics MPC4Mk2 + IOC4Mk2 SIL module and RLC16Mk2 SIL 
module both run diagnostics 

 

Up to 2 × tachometer (speed) channels 1 × tachometer (speed) channel only 

Tachometer (speed) channel signals can be freely 
shared via the VM600Mk2/VM600 rack’s Tacho bus. 

Note: MPC4Mk2 + IOC4Mk2 module can put signals on 
and take signals from the Tacho bus. 

Tachometer (speed) channel signals cannot be as freely 
shared via the VM600Mk2/VM600 rack’s Tacho bus. 

Note: MPC4Mk2 + IOC4Mk2 SIL module can put signals on 
but cannot take signals from the Tacho bus. 

 

Digital high-pass filter (HPF) cutoff frequency up to 15 kHz Digital high-pass filter (HPF) cutoff frequency up to 400 Hz 

 
Up to 4 × user-configurable relays (RL1 to RL4) and 

1 × common circuit-fault relay (FAULT). 
Note: In standard applications, use of the 

FAULT relay is optional. 

Up to 4 × user-configurable relays (RL1 to RL4) and 
1 × common circuit-fault relay (FAULT). 

Note: In safety-related applications, use of the 
FAULT relay is mandatory. 

Up to 16 × user-configurable relays (RL1 to RL16) per additional RLC16Mk2 / RLC16Mk2 SIL module 

User-configurable relays can be configured as 
normally energized (NE) or normally de-energized (NDE) 

User-configurable relays must be configured as 
normally energized (NE) 

Alarms and relays can be configured as latched or not latched 

 

Machinery is protected when the MPC4Mk2 module’s 
operational mode is Locked or Unlocked 

Machinery is protected only when the MPC4Mk2 SIL 
module’s operational mode is Locked. 

Note: In safety-related applications, a MPC4Mk2 SIL module 
can only run in the Locked operational mode. 
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System (MPC4Mk2 + IOC4Mk2 module and any 
RLC16Mk2 modules) does not enter the safe state (fail-safe 

mode) if an input channel saturates 

System (MPC4Mk2 SIL + IOC4Mk2 SIL module and an 
RLC16Mk2 SIL module) enters the safe state (fail-safe 

mode) if an input channel saturates for more than 1 hour 
 

Live insertion and removal of modules (hot-swapping) with 
automatic reconfiguration is permitted. 

That is, a replaced MPC4Mk2 module will be auto-configured 
by its associated IOC4Mk2 module. 

Live insertion and removal of modules (hot-swapping) with 
automatic reconfiguration is not permitted. 

That is, a replaced MPC4Mk2 SIL module will not be 
auto-configured by its associated IOC4Mk2 SIL module. 

 

Verification of MPC4Mk2 module’s 
serial number by the VibroSight® software 

Verification of MPC4Mk2 + IOC4Mk2 SIL module’s 
serial numbers by the VibroSight® software 

Protection configuration signature 
not required 

Protection configuration signature 
(SIL system signature) required 

Enforcing of VM600Mk2 system (MPC4Mk2 + IOC4Mk2 
and RLC16Mk2) configuration rules by the 

VibroSight® software 

Enforcing of VM600Mk2 SIL system (MPC4Mk2 + IOC4Mk2 SIL 
and RLC16Mk2 SIL) configuration rules by the 

VibroSight® software 
 

Notes 
For standard applications, a VM600Mk2 system consists of only standard versions of modules: MPC4Mk2 + IOC4Mk2 
modules and optional RLC16Mk2 modules. A CPUMMk2 + IOCNMk2 rack controller and communications interface module 
can also be used in such systems. 
For safety-related applications (functional-safety contexts), a VM600Mk2 system consists of only SIL versions of modules: 
MPC4Mk2 + IOC4Mk2 SIL modules and optional RLC16Mk2 SIL modules. 
Standard versions of VM600Mk2 modules must be used with other standard VM600Mk2 modules, while VM600Mk2 SIL 
modules must be used with other VM600Mk2 SIL modules. More specifically, VM600Mk2 modules and VM600Mk2 SIL 
modules are not compatible, for example, it is not possible to use a MPC4Mk2 module with a IOC4Mk2 SIL module, and 
vice versa. 
A VM600Mk2 SIL system (MPC4Mk2 + IOC4Mk2 SIL) allows 1 × tachometer (speed) channel only since both auxiliary 
channel inputs must be configured and used to provide a single redundant tachometer input in safety-related 
applications (functional-safety contexts). 
A VM600Mk2 SIL system (MPC4Mk2 + IOC4Mk2 SIL and an optional RLC16Mk2 SIL) will enter the safe state (fail-safe 
mode) whenever the module diagnostics (built-in self-test (BIST)) detects an issue that prevents normal operation, for 
example, hardware faults/problems, significant differences in the measurements from the redundant electronics 
processing modules, etc. 
In the safe state (fail-safe mode), the MPC4Mk2 SIL module activates the system-wide VM600Mk2 system safety-line 
control signal in order to automatically drive all system relays and analog outputs to a safe state. The MPC4Mk2 SIL 
module also activates its status relay (common circuit-fault relay (FAULT) relay) in order to allow issues to be remotely 
detected/indicated. Front-panel LEDS are used for local indication. 
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2.2 VibroSight Protect Dashboard improvements 

The Dashboard tab/page in VibroSight Protect has been refactored in order to improve communications 
(connections) with VM600Mk2 modules, provide more information to the user, and enhance general operation and 
stability. 

As a result, VibroSight Protect now displays the information available from a VM600Mk2 module whenever possible 
– irrespective of the status of any other VM600Mk2 modules in the rack. (Previously, VibroSight Protect would not 
always display the information available from a module, if there was an issue with other modules that prevented 
their information from being displayed.) 

Further, in VibroSight Protect, the VM600Mk2 rack image (representation) shown on the Dashboard tab/page (main 
window, top) now incorporates summary information for each populated rack slot (module position) in the rack. 

More specifically, when a VM600Mk2 rack is selected in the Dashboard tab/page, icons with tooltips are available for 
each rack slot in order to allow the user to quickly and easily determine the status of all of the modules in the rack, 
as follows: 

 

Icon Tooltip(s) 

 “Trying to connect …” 

 
“The module active configuration doesn’t match the Protect file configuration. 

A system activation is required to display the module dashboard.” 

 

“The module is currently not reachable on the network. Please check your network 

connectivity and ensure that the rack is powered on.” 

“The firmware on the module is not compatible with this VibroSight software version. 

Please upgrade the firmware on the module to the latest version or use a compatible 

version of VibroSight.” 

“The module is not inserted in the correct rack slot number. Please relocate the 

module so the Protect configuration matches the physical rack slot assignment.” 

“The module is not ready. Please wait for the module to finish initializing.” 

“There is no machinery protection configuration activated in the module.” 

“The module is not in Running mode. Please use the module front panel buttons to set 

the Running mode.” 

“The MPC4 card serial number doesn’t match the serial number in the configuration. 

Please verify that the MPC4 card manual IP address and serial number are correct.” 

“The IOC4 SIL card serial number doesn’t match the serial number in the 

configuration. Please verify that the IOC4 SIL card serial number is correct.” 

“There is an unknown error on the module.” 

 “The module is in fail safe mode. Error: [<error number>] <Error message>” 
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NOTE: All of the icons and tooltips given above are applicable to the standard and SIL 
versions of the MPC4Mk2 + IOC4Mk2 module. 

Some of these icons and tooltips are applicable to the CPUMMk2 + IOCNMk2 module. 

No status information (icons and tooltips) are displayed for the RLCMk2 module. 

 

 

2.3 VibroSight Vision and the display of states 

VibroSight Vision has been improved in order to allow for the easier display of state-related information, that is, 
status information for modules or systems associated with any state entities (measurements) such as Boolean 
information, alarm states and/or state groups (OPC UA). 

NOTE: Please note that the Hardware view in VibroSight Vision (and VibroSight Mimic) 
has been renamed to the System view, as part of this work. 

 
Accordingly, in VibroSight Vision’s System view or Machinery view (left), when a module or other system 
component is selected in the top pane, then the available measurements are displayed in the bottom pane. 
Similarly, if an OPC UA states group node is selected in the top pane, then the corresponding OPC UA states are 
displayed in the bottom pane. 
Further, the search box at the top of the measurements pane (bottom) allows for the filtering of the available 
measurements/states. For example, typing state in the search measurements box will result in only state entities 
(and any other measurements containing the “state”) being displayed. 
Note: State entities are indicated by a double circle icon (  ) in the System view and Machinery view windows 
(bottom pane). 

 
In VibroSight Vision, state entities (measurements) are treated like any other data type in VibroSight. For example, 
double-clicking on a state entity in the System view or Machinery view window (bottom pane) will display the state-
related information for the configured time range in a Trend plot. State entities can also be dragged to existing plots 
in the usual way in order to add entities as new curves in the plot, with a dedicated legend entry, etc. 
Note: The Trend plot (Time/APHT) is the default plot type for the display of live state entity data while the Trend plot 
or the Long waveform plot can be used for historical state entity data. 

 
In the plot, a state entity data curve is displayed as a series of straight lines with two dots/points (with the same 
timestamp) for every state value change: one dot for the value before the change and one dot for the value after 
the change. 
In the plot, the X-axis uses time while the Y-axis automatically uses the range of possible values (states) for the 
displayed state entity or entities. 
Also, the contents of a Trend plot or a Long waveform plot containing state entity data can be export in the usual 
way (plot window, right-click and Export plot data). 

 

See also 2.4 New VibroSight Mimic indicator. 
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2.4 New VibroSight Mimic indicator 

In VibroSight Mimic, a new indicator has been added in order to allow the display of system information: 

• State indicator – for the display of status information for modules or systems, that is, it can be associated with 
any state entities (measurements) such as Boolean information or alarm states. 
Note: State entities are indicated by a double circle icon (  ) in the System view and Machinery view 
windows. 

In addition, when system data is enabled in the System view (System view window, right-click and 
Show system data), various state entities such as the status of VibroSight Protect alarm controls (danger bypass, 
trip multiply), logical function status, relay status, sensor status and much more can also be displayed. 

 

When VibroSight Mimic is in the Edit mode, the Boolean indicator is available in the Toolbox window that is 
displayed (right). To add an indicator, or any other Mimic control to a Mimic document, drag a control from the 
toolbox to the main document (centre). To associate (link) a machine/system component with a Mimic indicator, 
drag the machine/system component from the Machinery (or Hardware) view (left) to the indicator in the main 
document (centre). To configure the Mimic indicator, use the Properties window that is displayed (right). 

See also 2.3 VibroSight Vision and the display of states. 
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VM600Mk2 modules 

2.5 MPC4Mk2 + IOC4Mk2 module – hardware (standard and SIL versions) 

The MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module and the RLC16Mk2 relay module are 
available in different versions – standard and SIL – as follows: 

• MPC4Mk2 + IOC4Mk2 and RLC16Mk2 – these are the standard versions of the modules, suitable for most 
applications. 
Note: PNRs 600-041 for the MPC4Mk2, 600-043 for the IOC4Mk2 and 600-045 for the RLC16Mk2. 

• MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL – these are the SIL safety versions of the modules, suitable for 
critical applications demanding the highest level of protection. 
Note: PNRs 600-040 for the MPC4Mk2 SIL, 600-042 for the IOC4Mk2 SIL and 600-044 for the RLC16Mk2 SIL. 

 

See also 2.6 MPC4Mk2 + IOC4Mk2 module – firmware and 2.7 MPC4Mk2 + IOC4Mk2 SIL module – firmware. 
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2.6 MPC4Mk2 + IOC4Mk2 module – firmware 

NOTE: Standard versions of firmware are for use with the MPC4Mk2 + IOC4Mk2 module only 
(that is, PNR 600-041 for the MPC4Mk2). 

 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module firmware with 
the following main improvements: 

 

Machinery protection firmware: 640-025-009-001 

NOTE: VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-009-001) is 
compatible with both versions of the MPC4Mk2 module (PNRs 600-041-000-vvv and 
600-041-001-vvv). 

 

Features: 

• Module relays now activate (“trip”) for a minimum time of 500 milliseconds. 
Note: This makes it easier for external third-party systems such as a DCS or PLC to reliably detect relay 
activation, even where relay latching is not used. 

Bug fixes: 

• The alarm bypass (AB) signal received via the discrete signal interface (DSI), that is, an external signal via the 
IOC4Mk2 module’s J2 connector, is incorrectly being latched if the Alarm reset (AR) button on a CPUMMk2 
module in the same rack is used (when the alarm bypass (AB) is active). 

• Alarm events were being evaluated and generated during the stabilization phase. 

• Overspeed and underspeed flags were not being raised when speed was outside of the tracking range (for 
signal processing using order tracking). 

• Shaft absolute vibration processing and measurements were incorrect (due to constituent bearing absolute 
vibration processing not being integrated to the same level as constituent shaft relative vibration processing). 

• Module could enter Power-up mode from Operational mode (unlocked (maintenance operating mode)) when 
being reconfigured. 

• Sensor/channel bypass was not working properly under all circumstances, notably for dynamic channels using 
auxiliary channels configured with two speed measurements (Dual shaft) as speed references. 

Restrictions: 

• Compatible with VibroSight 7.4. 

See also 5.2 VM600Mk2/VM600 modules/cards. 
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Condition monitoring firmware: 640-033-005-000 

Bug fixes: 

• Dual-channel processings with many frequency domain extractions were not being indexed correctly, resulting 
in some configurations being refused even though they were valid. 

• Overspeed and underspeed flags were not being raised when speed was outside of the tracking range (for 
signal processing using order tracking). 

• Sensor/channel bypass was not working properly under all circumstances, notably for dynamic channels using 
auxiliary channels configured with two speed measurements (Dual shaft) as speed references. 

Restrictions: 

• Compatible with VibroSight 7.4. 

See also 5.2 VM600Mk2/VM600 modules/cards. 

 

 

2.7 MPC4Mk2 + IOC4Mk2 SIL module – firmware 

NOTE: SIL versions of firmware are for use with the MPC4Mk2 + IOC4Mk2 SIL module only 
(that is, PNR 600-040 for the MPC4Mk2 SIL). 

 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 SIL machinery protection and condition monitoring module firmware with 
the following main improvements: 

 

SIL machinery protection firmware: 640-024-001T006 

Features: 

• Module relays now activate (“trip”) for a minimum time of 500 milliseconds. 
Note: This makes it easier for external third-party systems such as a DCS or PLC to reliably detect relay 
activation, even where relay latching is not used. 

Bug fixes: 

• Alarm events were being evaluated and generated during the stabilization phase. 

• Overspeed and underspeed flags were not being raised when speed was outside of the tracking range (for 
signal processing using order tracking). 

• Shaft absolute vibration processing and measurements were incorrect (due to constituent bearing absolute 
vibration processing not being integrated to the same level as constituent shaft relative vibration processing). 

• Module could enter Power-up mode from Operational mode (unlocked (maintenance operating mode)) when 
being reconfigured. 

• Sensor/channel bypass was not working properly under all circumstances, notably for dynamic channels using 
auxiliary channels configured with two speed measurements (Dual shaft) as speed references. 
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Restrictions: 

• Compatible with VibroSight 7.4. 

See also 5.2 VM600Mk2/VM600 modules/cards. 

 

NOTE: It is important to be aware that the current SIL versions of the VM600Mk2 modules 
are “beta” versions for test and evaluation only. 
The SIL certification process is ongoing and SIL certification is pending, so the 
MPC4Mk2 module cannot be Locked (that is, cannot be put into the safety/secure 
operating mode (of the Operational mode)). 
Accordingly, firmware upgrades to final versions of SIL-specific firmware will be 
required before a VM600Mk2 SIL system containing MPC4Mk2 + IOC4Mk2 SIL 
modules can be used in critical safety-related applications. 
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3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 7.4.0 software. 

 

3.2 VibroSight Vision displays temperature values from XMx16 + XIO16T modules incorrectly 

In VibroSight Vision, for XMx16 + XIO16T extended condition monitoring modules with dynamic input channels / 
processing blocks configured to provide temperature measurements, incorrect temperature values (DC extractions 
/ data entities) were displayed due to incorrect conversions between K (as used internally by VibroSight for 
temperature) and °C. 

 

3.3 VibroSight Server air-gap processing errors with XMx16 + XIO16T modules 

When air gap and flux processing was configured for XMx16 + XIO16T extended condition monitoring modules but 
one or more Gap P%n measurements (data extractions) were disabled for one or more probes (air-gap sensors), 
the VibroSight Server experienced post-processing errors and was unable to provide any air-gap data to 
VibroSight Vision. 

 

3.4 VibroSight Capture not opening certain older configurations 

VibroSight Capture was not opening certain older configurations, typically configurations containing multiple 
machine trains characterised by a number of larger machinery components (such as generators and hydro 
turbines). 

 

3.5 VibroSight Capture not opening older configurations containing logical functions with 
empty gates 

VibroSight Capture was not opening older configurations (VibroSight 7.1.x) containing logical functions with empty 
input gates. 

 

3.6 VibroSight Capture Connect tab/page not distinguishing axial sensors 

In VibroSight Capture, on the Connect tab/page used for associating sensors with machine train components, 
when an axial sensor (that is, a sensor configured in VibroSight Protect with an axial mounting position 
(orientation)) was connected with a machinery component, nothing was displayed inside the sensor position icon 
(circle) added to the machine train image (top). 

This has been corrected so that the added sensor position icon is now filled with the color associated with the 
applicable sensor family – in order to make the sensor position icon more visible and provide additional information 
about the sensor to the user. 



 

RELEASE NOTES 
VibroSight® 7.4.0 
22 / 68 

Document reference VIBROSIGHT-RN/E (660-010-013-237A) 
Version 37 – 18.09.2023 

 

3.7 VibroSight Capture not activating a system due to module reboot time 

VibroSight Capture was not able to activate a configuration on a system due to the time required for 
VM600Mk2 MPC4Mk2 modules to reboot. 

NOTE: This particular issue was noticed following an upgrade from VibroSight 7.1.x to 
VibroSight 7.2.x. 

 

3.8 VibroSight Capture database logging rule measurements not filtering as expected 

In VibroSight Capture, on the Data tab/page used for managing system data, under Database logging rules, when 
configuring Measurements for a logging rule, the filtering based on configured system data was not working as 
expected. 

This was characterised by the consistency checker incorrectly reporting errors/warnings that should not exist, 
for example, “The logging rule … measurements filter configured matches 0 measurements.” 
even though a configured machine train name was correct and used correctly by a measurements logging rule. 

 

3.9 VibroSight Capture slow to create or change VibroSight Servers 

In VibroSight Capture, the time taken to create a VibroSight Server (File > Save as server) and/or apply changes to 
a server (File > Apply changes to active configuration) could be too long. That is, operations expected to take 
seconds could take minutes, depending on the configuration (notably, the evaluation of data logging rules). 

 

3.10 VibroSight Vision issue displaying a measurement when connected to two 
VibroSight Servers 

In VibroSight Vision, when connected to two VibroSight Servers, it was not possible to add a measurement 
(data entity) to a plot. This was characterised by VibroSight Vision reporting “An unexpected error 
occurred. (Unexpected Error – NullReferenceException)”. 

 

3.11 VibroSight Vision incorrectly showing the direction of rotation in plots as 
counter clockwise (CCW) 

In VibroSight Vision, Polar plots and Orbit plots were displayed with the direction of rotation incorrectly shown as 
counter clockwise (CCW), even when the direction of rotation had been configured as clockwise in 
VibroSight Capture (Machinery tab/page, Machine train properties). 
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3.12 VibroSight Capture condition monitoring based on X-Y shaft bearing absolute vibration 
processing or X-Y shaft relative vibration processing has specific speed reference 
requirements 

In VibroSight Capture, when configuring condition monitoring processing based on X-Y shaft bearing absolute 
vibration processing or X-Y shaft relative vibration processing, certain measurements require that a 
Reference speed (tacho) is configured for the individual X and Y channels (in VibroSight Protect) in order for the 
condition monitoring configuration to be accepted and work as expected. 

More specifically, the following measurements require a configured reference speed on both X and Y processing 
blocks (individual X and Y channels): 

• Filtered orbits 

• Unfiltered orbits 

• Full-spectrum frequency-domain measurements configured in function of nX. 

The VibroSight software has been improved, such that if the required Reference speed (tacho) is not configured as 
required for these measurements, then the following activation error messages are displayed: 

• Filtered orbit: “The speed reference must be set when the input channel is used in a 
dual channel processing that contains filtered orbits.” 

• Unfiltered orbit: “The speed reference must be set when the input channel is used in a 
dual channel processing that contains unfiltered orbits.” 

• Full-spectrum frequency-domain measurements configured in function of nX: “The speed reference must 
be set when the input channel is used in a dual channel processing that contains 
full spectrum frequency domain measurements configured in orders.”. 

 

3.13 VibroSight Vision displays an incorrect message when trying to connect to an 
incompatible VibroSight Server via an IP address 

In VibroSight Vision, when trying to connect to an incompatible VibroSight Server (File > Data source manager) via 
an IP address (Running at the IP address), VibroSight Vision will display a message to the effect that the server 
cannot be reached ("Server not available") when it should display a message to the effect that the server is 
not compatible (“Incompatible version”). 

 

3.14 VibroSight Server using too much memory 

Depending on the configuration, VibroSight Server could use too much memory when running regular incremental 
copy jobs (periodic File storage) as part of the server’s data management. 

For larger systems consisting of multiple VM600/VM600Mk2 racks and running frequent file storage operations 
(of the order of 10 ), the VibroSight Server could consume >10 GB of computer memory, leading to slow operation 
of the computer/system and/or resulting in the system failing to respond (that is, crashing). 
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3.15 VibroSight Protect relay configuration problem after copying logical functions 

In VibroSight Protect, after copying a logical function on a MPC4Mk2 module for reuse as the basis of another logical 
function (via the configuration toolbar, left), relays on a RLC16Mk2 module could not be configured to use these 
logical functions as inputs. 

This problem was characterised by VibroSight Protect reporting “Error encountered: The selected input 
cannot be assigned since there are no RAW bus or OC bus lines available or one of the 
device doesn’t support the required bus to drive this relay.”. 

 

3.16 VibroSight Capture performance issues 

In VibroSight Capture, there were a number of performance issues that became apparent when working on larger 
systems consisting of multiple VM600/VM600Mk2 racks containing multiple machine trains characterised by a 
number of larger machinery components. 

For example, on the Machinery tab/page used for developing/configuring machine train images/properties (and 
facilities/locations), when CTRL+click and/or SHIFT+click were used to select multiple different machinery 
components across multiple different machine trains, VibroSight Capture could fail to respond (that is, crash). 

Similarly, VibroSight Capture could be slow to respond (or even crash) during certain routine operations such as 
running a consistency check, saving the configuration as a server or applying configuration changes. 

 

3.17 VibroSight Capture OPC UA device authentication settings with optional password 

In VibroSight Capture, on the Systems tab/page used for configuring the devices used to import data into a 
VibroSight System, when adding an OPC UA device and configuring its Authentication settings, it was not possible 
to configure User name or Certificate based settings without adding an associated password (as the password field 
had to be completed in order to be able to close the Authentication settings window using the OK button). 

This has been corrected such that it is now possible to configure User name or Certificate based settings without a 
password (that is, the password is now optional for OPC UA device authentication). 
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4 Known issues 

4.1 Security risks 

A number of Open web application security project (OWASP) security risks have been identified related to a 
UPC UA library used by the VibroSight software. This UPC UA library is from a third-party (Softing AG, Softing 
Industrial Automation GmbH), who have recently implemented a fix. However the improved UPC UA library is not 
included in the latest release of VibroSight. 

For information, the specific issues that have been identified are: 

• CVE-2022-29862: An infinite loop in OPC UA .NET Standard Stack 1.04.368 allows a remote attackers to 
cause the application to hang via a crafted message 

• CVE-2022-29863: OPC UA .NET Standard Stack 1.04.368 allows remote attacker to cause a crash via a 
crafted message that triggers excessive memory allocation. 

• CVE-2022-29864: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to cause a server to crash 
via a large number of messages that trigger Uncontrolled Resource Consumption. 

• CVE-2022-29865 : OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to bypass the application 
authentication check via crafted fake credentials 

• CVE-2022-29866: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to exhaust the memory 
resources of a server via a crafted request that triggers Uncontrolled Resource Consumption. 

 

4.2 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

4.3 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

4.4 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 
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NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 

NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 

4.5 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 

4.6 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 modules/cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 



 

Document reference VIBROSIGHT-RN/E (660-010-013-237A) 
Version 37 – 18.09.2023 

RELEASE NOTES 
VibroSight® 7.4.0 

27 / 68 
 

4.7 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 

 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 

4.8 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 
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If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 

4.9 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 

4.10 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 

4.11  XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 
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4.12  Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully run. 

NOTE: The VibroSight software’s TCP and UDP port requirements are described in detail 

in the “Software installation” section of the latest  Getting started with 
VibroSight installation guide. See section 4. After installing VibroSight. 

 

4.13  Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 
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This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 
 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

 

  

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 0) must be manually installed before 
VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 0) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 0) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

5.1 VibroSight software 

VibroSight 7.4.0 is a minor level release and replaces VibroSight 7.3.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved by automatically applying an 
internal data migration process from existing VibroSight databases (VibroSight historical data folders (*.vshdf) 
and/or VibroSight historical data archives (*.vshda)), if and when required. 

NOTE: Starting with VibroSight 7.4.0, it is no longer possible to migrate older machinery 
monitoring projects using Sybase SQL Anywhere databases to VibroSight historical 
data repositories. 

In order to migrate such older projects using Sybase SQL Anywhere databases to 
VibroSight historical data repositories, VibroSight 7.3.x or earlier 
(also VibroSight 3.x.x or later) must be used. 

 
Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 7.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 
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• For existing machinery monitoring projects using VibroSight historical data repositories, the VibroSight 
historical data repositories are automatically updated if and when required (for example, to support new 
features). 

• For existing machinery monitoring projects using Sybase SQL Anywhere databases (that is, created with 
versions of VibroSight earlier than VibroSight 3.0.0), the project must be manually migrated from Sybase SQL 
Anywhere databases to VibroSight historical data repositories. 

Note: This data migration must be done using VibroSight 7.3.x or earlier (also VibroSight 3.x.x or later) – before 
they can be used with VibroSight 7.x.x (also VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.3.x or earlier (also VibroSight 3.x.x or later) is described in detail in the 

“Data migration” section of the  Getting started with VibroSight installation 
guide  
(Note: For example, using the VibroSight 7.3.x software – see the previous version 
of the installation guide: version 33.) 

The manual migration of a VibroSight OPC server is described in detail in the 
“VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide  
(Note: For example, using the VibroSight 7.4.x software – see the latest version of 
the installation guide: version 34.) 

 
5.1.1 Microsoft Windows operating systems 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 
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5.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 7.4.x requires that the .NET 7.0 SDK and the 
Microsoft .NET Framework 4.7.2 or later is installed. 

NOTE: VibroSight 7.4.x requires Microsoft .NET 7.0 SDK (v7.0.306 or later). 

VibroSight 7.x.x requires the Microsoft .NET Framework 4.7.2. 

 
If Microsoft .NET SDK v7.0.306 or later is not already installed on the computer that will run VibroSight, then it must 
be installed manually by the user using one of Microsoft’s .NET SDK installers. 

If Microsoft .NET Framework 4.7.2 is not already installed on the computer that will run VibroSight, then the 
VibroSight installer will detect this and automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 

requirements. Refer also to the latest  Getting started with VibroSight installation guide. 

 

5.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 
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If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

5.1.5 OPC UA Local Discovery Server  

VibroSight 7.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 

 

5.1.6 Sybase SQL Anywhere 11 software 

VibroSight 7.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 7.4.0, it is no longer possible to migrate older machinery monitoring projects using Sybase 
SQL Anywhere databases to VibroSight historical data repositories. 

For further information on VibroSight and Sybase SQL Anywhere, including the manual migration of older projects 
using Sybase SQL Anywhere to VibroSight, refer to VibroSight 7.3.x or earlier release notes and/or installation 
guide. 

See also 5.1 VibroSight software. 

 

5.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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5.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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5.2 VM600Mk2/VM600 modules/cards 

5.2.1 Module/card firmware 

There are some firmware upgrades for VM600Mk2/VM600 modules (cards) corresponding to VibroSight 7.4.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 module is: 

• Machinery protection: 640-025-009-001.Mpc4g2Fw (updated) 

• Condition monitoring: 640-033-005-000.VxeFw (updated) 

• Recovery: 640-031-006-000.Mpc4g2Fw (no change) 

• Proof test: 640-032-004-000.VxeFw (no change). 

See 2.5 MPC4Mk2 + IOC4Mk2 module – hardware and 2.6 MPC4Mk2 + IOC4Mk2 module – firmware. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 SIL module is: 

• Machinery protection: 640-024-001T006.SafeMpc4g2Fw (updated) 

• Condition monitoring: 640-033-005-000.VxeFw (updated) 

• Recovery: 640-026-001-000.SafeMpc4g2Fw (no change) 

• Proof test: 640-032-004-000.VxeFw (no change). 

See 2.5 MPC4Mk2 + IOC4Mk2 module – hardware and 0  

 

MPC4Mk2 + IOC4Mk2 SIL module – firmware. 

 

The latest firmware for the VM600Mk2 CPUMMk2 module remains: 

• Base system: base-system-640-034-003-001.tgz. 

 

The latest firmware for the VM600 CPUR2 card remains: 

• Applications: applications-640-015-001-006.tgz 

• Base System : base-system-640-014-001-006.tgz. 

 

The latest firmware for the VM600 CPUR card remains: 

• Applications: applications-640-012-001-005.tgz 

• Base System: base-system-640-011-001-005.tgz. 
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The latest firmware for the VM600Mk2/VM600 XMC16, XMV16 and XMVS16 cards remains: 

• Applications: applications-640-010-001-016.tgz 

• Base System: base-system-640-003-001-016.tgz. 

 

Therefore, for current versions of VibroSight and VM600Mk2/VM600 systems, firmware upgrades are required. 

 

 

5.3 VibroSmart devices 

5.3.1 Module firmware 

There are no firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 7.4.0. 

 

The latest firmware for the VSI010 module remains: 

• 642-002-000-014.xmsifw  

 

The latest firmware for the VSN010 device remains: 

• 642-004-000-012.redboxfw  

 

The latest firmware for the VSV30x module remains: 

• 642-001-000-020.xtranfw  

 

Therefore, for current versions of VibroSmart modules and devices, no firmware upgrades are required. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: Before starting a VibroSight system update, it is strongly recommended to verify 
the version of firmware(s) running on the related hardware (VM600Mk2/VM600 
and/or VibroSmart modules/devices) in order to establish if any firmware 
changes/upgrades are also required. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

IMPORTANT 
NOTE: 

Before upgrading the firmware of any of the hardware (VM600Mk2/VM600 and/or 
VibroSmart modules/devices) used in a VibroSight system, it is strongly 
recommended to ensure that a copy of the configuration for the system is available 
– in case it is necessary to reconfigure the system after the upgrade. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600Mk2/VM600 and/or VibroSmart 
modules/devices to be upgraded to the latest firmware, in order to take advantage of improvements to the 
VibroSight software. 

NOTE: Updating the firmware for VM600Mk2/VM600 and/or VibroSmart modules/devices is 
a special task that can, if used unintentionally or incorrectly, lead to malfunctioning 
of the device and affect proper function of data acquisition. It is therefore strongly 
recommended to change the firmware of VibroSight-compatible hardware only 
when it is necessary. For example, when the devices must be updated to be 
compatible with a VibroSight software upgrade. 

During the firmware update of a device, the card or module being updated cannot 
provide its normal machinery monitoring functions because its outputs (alarms and 
relays) can go to undetermined states, irrespective of how they have been 
configured. 

 

IMPORTANT 
NOTE: 

It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

For example, for VibroSmart modules, the machinery being monitored is not protected for the duration of a 
firmware update and the restart (reboot) that is triggered automatically after the firmware update (which can take up 
to 5 minutes). 
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6.2.1 VM600Mk2/VM600 module/card firmware 

The latest VM600Mk2/VM600 module/card firmware files are copied to a directory on your computer as part of the 
VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600Mk2/VM600 modules/cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600Mk2/VM600 module/card can be found in the appropriate subfolder and identified by 
their .tgz file name extension. 

For example, the MPC4 Mk2 subfolder contains the firmware components for use by the MPC4Mk2 module 
(standard versions) and the MPC4 Mk2 SIL subfolder contains the firmware components for use by the 
MPC4Mk2 SIL module (SIL versions). Any additional firmware updates received from Meggitt SA should also be 
stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for later versions of the MPC4Mk2 (PNRs 600-041-001-002 and 600-041-000-002). 

Table 2 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for the original version of the MPC4Mk2 (PNR 600-041-000-001) – no longer supported. 
See 2.5 MPC4Mk2 + IOC4Mk2 module – hardware. 

Table 3 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 SIL module hardware (that 
is, MPC4Mk2 SIL firmware). 

IMPORTANT 
NOTE: 

When changing (upgrading) all firmware components on a VM600Mk2 MPC4Mk2 
module, the module must be in the Recovery mode in order to change the 
proof test firmware. 

It is important to note that entering the Recovery mode clears the modules 
configuration, which means that the module (system) must be reconfigured after 
leaving the Recovery mode – before normal system operation can be resumed. 

Accordingly, it is strongly recommended to ensure that a copy of the configuration 
for the system is available before upgrading a system. For example, the VibroSight 
software can be used to connect to a system (which will automatically 
read/download the system configuration) and save a copy of the configuration. 

 

 

Table 4 shows the compatibility between VibroSight software and VM600Mk2 CPUMMk2 module hardware (that is, 
CPUMMk2 firmware). 

Table 5 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 6 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 
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Table 7 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 
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Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

for later standard versions of the MPC4Mk2 (PNRs 600-041 / 600-041-001-002 and 600-041-000-002) 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

640-025- 

007-001 

640-025- 

008-000 

640-025- 

009-001 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- 640-033- 

001-000 

640-033- 

002-000 

640-033- 

003-000 

640-033- 

004-000 

640-033- 

005-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-006 

640-031- 

005-001 

640-031- 

006-000 

Proof test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-001 

640-032- 

003-000 

640-032- 

004-000 

7.0.0 
609-010-000-001 

 See note 1a  See note 1b 
    

7.1.0 
609-010-000-001 

   See note 2 
   

7.2.0 
609-010-000-001 

    See note 3 
  

7.3.0 
609-010-000-001 

     See note 4 
 

7.4.0 
609-010-000-001 

      See note 5 

 

Notes for Table 1 (see the next page) 
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Notes for Table 1 
 
1a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 
1b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 
2. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 
3. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.2 release notes. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
 
4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is required in order to run VibroSight 7.3.0 or later. 
 
5. For information on these versions of VM600Mk2 MPC4Mk2 firmware, see 2.5 MPC4Mk2 + IOC4Mk2 module – hardware (standard and SIL 
versions) and 2.6 MPC4Mk2 + IOC4Mk2 module – firmware. 
A firmware upgrade is required in order to run VibroSight 7.4.0 or later. 
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Table 2: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

for the original standard version of MPC4Mk2 (PNRs 600-041 / 600-041-000-001) – no longer supported 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

003-002 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- --- 640-033- 

001-000 

640-033- 

002-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-002 

640-031- 

003-004 

640-031- 

003-006 

Proof test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-000 

640-032- 

001-001 

6.0.0 
609-004-000-050 

 See note 1  
   

6.1.0 
609-004-000-051 

  See note 2   
 

7.0.0 
609-010-000-001 

   See note 3a  See note 3b 
 

7.1.0 
609-010-000-001 

     See note 4 

 

Notes for Table 2 (see the next page) 
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Notes for Table 2 
 

1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – that is, to use VM600Mk2 
systems in “live” machinery protection system (MPS) applications. Contact Meggitt SA for further information. 
 

2. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 
3a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

3b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0. 
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Table 3: VibroSight software and VM600Mk2 MPC4Mk2 SIL firmware compatibility 

for the SIL version of the MPC4Mk2 (PNRs 600-040 / 600-040-vvv-vvv) 

 VM600Mk2 MPC4Mk2 SIL firmware 

VibroSight software version 

Part number (PNR) 

SIL machinery protection firmware 
(640-024-vvv-ppp.SafeMpc4g2Fw) 

640-024-001T005 640-024-001T006 

Condition monitoring firmware 
(640-033-vvv-ppp.VxeFw) 

640-033-004-000 640-033-005-000 

SIL recovery firmware  
(640-026-vvv-ppp.SafeMpc4g2Fw) 

640-026-001-000 

Proof test firmware 
(640-032-vvv-ppp.VxeFw) 

640-032-004-000 

7.3.0 
609-010-000-001 

 See note 1  

7.4.0 
609-010-000-001 

  See note 2 

 

Notes for Table 3 
 
1. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is required in order to run VibroSight 7.3.0 or later. 
 
2. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, see 2.5 MPC4Mk2 + IOC4Mk2 module – hardware (standard and SIL 
versions) and 0  
 
MPC4Mk2 + IOC4Mk2 SIL module – firmware. 
A firmware upgrade is required in order to run VibroSight 7.4.0 or later. 
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Table 4: VibroSight software and VM600Mk2 CPUMMk2 firmware compatibility 

 VM600Mk2 CPUMMk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Base-system / Applications firmware (*.tgz) 

640-034- 

001-000 

640-034- 

001-001 

640-034- 

002-000 

640-034- 

003-000 

640-034- 

003-001 

6.1.0 
609-004-000-051 

 See note 1   
  

7.0.0 
609-010-000-001 

  See note 2  
  

7.1.0 
609-010-000-001 

   See note 3  
 

7.2.0 
609-010-000-001 

    See note 4 
 

7.3.0 
609-010-000-001 

     See note 5 

7.4.0 
609-010-000-001 

     

 

Notes for Table 4 
 

1. This version of VM600Mk2 CPUMMk2 firmware is the official launch release of firmware supporting VM600Mk2 systems. (Refer to the 
VibroSight 6.1 release notes for further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

2. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

3. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

4. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.2 release notes. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
 

5. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.3 release notes. 
A firmware upgrade is not required but is strongly recommended in order to run VibroSight 7.3.0 or later. 
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Table 5: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-014- 

001-001 

640-014- 

001-002 

640-014- 

001-003 

640-014-001-

005 

640-014-001-

006 

Applications firmware (*.tgz) 

640-015- 

001-001 

640-015- 

001-002 

640-015- 

001-003 

640-015- 

001-005 

640-015- 

001-006 

4.0.0 
609-004-000-046 

 See note 2  See note 3   
 

4.1.0 
609-004-000-047 

   See note 4  
 

5.0.0 
609-004-000-048 

    
 

5.1.0 
609-004-000-049 

    
 

6.0.0 
609-004-000-050 

    
 

6.1.0 
609-004-000-051 

    
 

7.0.0 
609-010-000-001 

    See note 5 
 

7.1.0 
609-010-000-001 

     See note 6 

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

7.4.0 
609-010-000-001 

     

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for 
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is 
required in order to run VibroSight 2.12.7 or later. 
 

3. This version of VM600 CPUR2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to 
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly 
recommended in order to run VibroSight 3.4.0 or later. 
 

4. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
 

5. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

6. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 6: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-011-001-004 640-011-001-005 

Applications firmware (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 
609-004-000-046 

 See note 2  

4.1.0 
609-004-000-047 

  See note 3 

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

6.0.0 
609-004-000-050 

  

6.1.0 
609-004-000-051 

  

7.0.0 
609-010-000-001 

  

7.1.0 
609-010-000-001 

  

7.2.0 
609-010-000-001 

  

7.3.0 
609-010-000-001 

  

7.4.0 
609-010-000-001 

  

 

Notes for Table 6 (see the next page)  
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Notes for Table 6 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-vvv)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 
 
3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 7: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-003-001-016 

Applications firmware (*.tgz) 

640-010-001-016 

4.0.0 
609-004-000-046 

 See note 2 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

6.1.0 
609-004-000-051 

 

7.0.0 
609-010-000-001 

 

7.1.0 
609-010-000-001 

 

7.2.0 
609-010-000-001 

 

7.3.0 
609-010-000-001 

 

7.4.0 
609-010-000-001 

 

 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw 
file name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 8 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 9 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 10 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 8: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-002-000-010 642-002-000-011 642-002-000-012 642-002-000-013 642-002-000-014 

5.0.0 
609-004-000-048 

See notes 

2 and 3 
See notes 

2 and 4 
See notes 

2 and 5 
 

 

5.1.0 
609-004-000-049 

    
 

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
See notes 

2 and 6 

 

7.0.0 
609-010-000-001 

    
 

7.1.0 
609-010-000-001 

    
See notes 

2 and 7 

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

7.4.0 
609-010-000-001 

     

 

Notes for Table 8 (see the next page)  
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Notes for Table 8 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 

4. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

6. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

7. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later.  
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Table 9: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
Part number (PNR) 

642-004-000-011 642-004-000-012 

5.0.0 
609-004-000-048 

 See note 2 
 

5.1.0 
609-004-000-049 

 
 

6.0.0 
609-004-000-050 

 
 

6.1.0 
609-004-000-051 

 
 

7.0.0 
609-010-000-001 

 
 

7.1.0 
609-010-000-001 

 
See notes 

2 and 3 

7.2.0 
609-010-000-001 

  

7.3.0 
609-010-000-001 

  

7.4.0 
609-010-000-001 

  

 

Notes for Table 9 (see the next page)  



 

RELEASE NOTES 
VibroSight® 7.4.0 
58 / 68 

Document reference VIBROSIGHT-RN/E (660-010-013-237A) 
Version 37 – 18.09.2023 

 

Notes for Table 9 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. For information on this version of VibroSmart VSN010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 10: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-001-000-017 642-001-000-018 

642-001-000- 

000DEV_ 

SVN14937_ 

2020-05-20 

642-001-000-019 642-001-000-020 

5.0.0 
609-004-000-048 

See notes 

2 and 3 
See notes 

2 and 4 

   

5.1.0 
609-004-000-049 

  
See notes 

2 and 5 
 

 

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
See notes 

2 and 6 

 

7.0.0 
609-010-000-001 

    
 

7.1.0 
609-010-000-001 

    
See notes 

2 and 7 

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

7.4.0 
609-010-000-001 

     

 

Notes for Table 10 (see the next page)  
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Notes for Table 10 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware adds support for configurable tacho ratios, flexible input channel to processing block mapping, 
and up to two tacho processing blocks. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

4. This version of VibroSmart VSV30x firmware adds support for module lock, PTP (precision time protocol) time synchronisation, channel 
bypass and pre-trigger data logging. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later. 

6. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

7. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600Mk2/VM600 and/or VibroSmart modules/devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600Mk2/VM600 and/or VibroSmart modules/devices 
firmware update may lead to incoherent system behaviour and affect the proper functioning of data acquisition in a 
system. It is only in systems where the firmware running on the VM600Mk2/VM600 and/or VibroSmart 
modules/devices already corresponds to the latest available version that no firmware update is required. Therefore, 
it is strongly recommended to verify the version of firmware running on the hardware before starting a VibroSight 
system upgrade, in order to establish if a firmware update is also required. 

NOTE: Updating the firmware for VM600Mk2/VM600 and/or VibroSmart modules/devices is 
a special task that can, if used unintentionally or incorrectly, lead to malfunctioning 
of the device and affect proper function of data acquisition. It is therefore strongly 
recommended to change the firmware of VibroSight-compatible hardware only 
when it is necessary. For example, when the devices must be updated to be 
compatible with a VibroSight software upgrade. 

During the firmware update of a device, the module or card being updated cannot 
provide its normal machinery monitoring functions because its outputs (alarms and 
relays) can go to undetermined states, irrespective of how they have been 
configured. 

 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 
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For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware 
(VM600Mk2/VM600 and/or VibroSmart modules/devices) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no VM600Mk2/VM600 and/or VibroSmart modules/devices in the tree structure or some are missing, 
verify your network connections. 

3. Select the module or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VM600Mk2/VM600 or VibroSmart modules/devices selected. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
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independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 
(VM600Mk2/VM600 modules/cards and /or VibroSmart modules) have been discovered and that data acquisition 
has resumed. 
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NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 
our main office: 

Customer support  
Meggitt SA 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

7.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows® operating system compatibility 

 

 
Windows 11 Windows 10 Windows 8.1 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 

 

 

VibroSight software and Windows® Server operating system compatibility 

 

 
Windows Server 2022 Windows Server 2016 Windows Server 2012 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 
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VibroSight software and Microsoft® .NET requirements 

VibroSight software version Microsoft .NET requirements 

VibroSight 7.4.x .NET 7.0 SDK v7.0.306 or later 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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